
  
Troubleshooting - - - - - - - - - - - - - - - - - - - - - - - - - 

After First AutoFill - No Assignments?  
  

To see what your employees Maximum Hours per day are:  

If AutoFilling your first schedule results in no workers being assigned to the shifts please check the following: 
 
1.  Are employees set to work your Positions? 

On the EMPLOYEE list page click the pencil icon next to the first employee's name.  
Check the boxes next to the Positions that this Employee can work.  
Click Save & Next to Edit the next Employee etc.  

 

  

2.  Are Employee maximum hours per day shorter than the "Paid Hours" (duration) of the shifts?  

In the top menu click EMPLOYEES to go to the Employee List page  
Check the Max Hours per Day & Week column (if this column is not visible use the "Select 

Columns to View" link in the upper left to make this column visible)  
To change the Max Hours click the pencil icon  next to the first employee's name.  
Correct the Max Hours and click Save & Next to go to the next employee etc.  

 



To see what your shift durations are:  

 

 

3.  Are your Shifts "Paid Hours" correct? (Using Auto Calc when adding shifts results in a shift duration that 
does not include deductions for lunch breaks etc.) The shift duration should be the total paid hours for that shift. 

From any Schedule View 
In the Schedule View dropdown choose Multi-Shift Edit  
Look at the "Duration" column which shows the hours worked for each shift and correct this if 

necessary for the shifts and click Save Changes (ex. an 8am to 5pm shift if set to Auto Calc will be 9 
hours - if you want that shift to be only 8 hours be sure to change it manually).  

Make changes to the shift durations if needed  
Click Save Changes  
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Nothing Happens when I Click...  
  
Sometimes when you click to do something in WhenToWork it appears that nothing is happening (the intended 
window does not pop up etc.). There are a number of things that can cause this. 

1. The window is already open behind the window you are in. Look at the status bar at the bottom of your 
browser and see if the window is already open - if so click on it to have it come to the front.  

2. This can also be caused by your browser using A Popup Blocker (sometimes you will hear a sound when 
the window is being blocked  

3. This can also be caused by not using the required browser:  

Related Topics:  
Popups windows are blocked - beeping 

  

PC Users

Internet Explorer or Firefox  
(free download) 

MAC Users

Firefox  
(free download)
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Popup Windows Not Opening 
  
Some sections of our system require that you allow popup windows.  Ex. Entering work time 
preferences.  If you are having trouble entering preferences or if your computer makes a beep or sound 
that indicates that popup windows are being blocked. You can either turn off your popup blocker or set 
your blocker up to allow popups from our web site. 

Turning OFF your Pop Up Blocker 

If you use Internet Explorer for windows 

If you use Firefox  ,  
                                               then hit button  

If you have a toolbar,  

                                       then click  to show   

If you have a Yahoo toolbar,  
                               then  <Turn off here. 

or Set your Pop Up Blocker to allow popups from WhenToWork.com 

Internet Explorer 

Detect if Internet Explorer is blocking a pop-up window 

A pop-up window may be blocked by Internet Explorer or one of its plugins, such as Google toolbar, 

If you see this icon underneath the address bar 

 or this icon on the status bar (at the 
bottom of the browser window), Internet Explorer has blocked a pop-up window. Follow the instructions 
below to unblock it. 

If you see this icon on the toolbar below the address bar, one of Internet Explorers plugins (such 
as Google or Yahoo toolbar) have blocked a pop-up window. Follow the instructions below to unblock it. 

Select Tools and then Turn Off Blocker

  



Unblock a pop-up window that has been blocked by Internet Explorer 

To unblock a pop-up window that Internet Explorer has blocked follow these steps: 

1. Click on the popup blocker icon  on the status bar (at the bottom of the browser window), to 
display the blocker menu  

2. From the menu select the "Always allow Pop-ups from This Site ..." option

  
3. Click on the Yes button to confirm  
4. Reload the webpage.  

This will make Internet Explorer save the WhenToWork.com web site in it's list of Allowed Sites so that 
in the future all pop-ups from WhenToWork.com webpages will be displayed. If the pop-up window is still 
being blocked then check that it's not being blocked by one of Internet Explorer's plugins. 

Unblock a pop-up window that has been blocked by an Internet Explorer plugin  

The following example demonstrates accepting a popup window that the Google toolbar plugin has 
blocked: 

1. From the Plugin toolbar left click on the icon (highlighted in red) shown in the image below: 
 

 
 
Clicking this button will allow all popups from WhenToWork.com web pages.  

If the popup window is still being blocked then check that it's not being blocked by Internet Explorer itself. 

Setting preferences in Internet Explorer to allow pop-ups from WhenToWork.com websites 

Another option is to change the default settings in Internet Explorer to allow popups from 
WhenToWork.com websites, to use that method follow the steps below: 

1. From the Tools menu select Pop-up Blocker >> Pop-up Blocker Settings ...



  
2. In the field titled Address of the website to allow type WhenToWork.com and click the Add 

button. The WhenToWork.com website should now appear in the list of allowed sites as shown 
below. 

  
3. Click on the Close button to save and exit  

The WhenToWork.com website will now be saved to your list of Internet Explorer Allowed Sites for pop-
up windows. Unfortunately, setting the Internet Explorer preferences to allow pop-ups from a site will not 
guarantee they will always be displayed. If you have an Internet Explorer plugin installed which is 
blocking pop-ups, it will need to be configured separately as shown above. 

Firefox 



Detect if Firefox is blocking a pop-up window

If below the address bar you see a toolbar like this appear: 

 

Then a pop-up has been blocked by Firefox. Follow the instructions below to unblock it. 

Unblock a pop-up window that has been blocked by Firefox  

To unblock a pop-up window that Firefox has blocked follow these steps: 

1. Click on the pop-up blocker toolbar (see image above) to display the blocker menu  
2. From the menu select the "Allow popups for WhenToWork.com" option  
3. Reload the page  

This will make Firefox save the WhenToWork.com web site in it's list of Allowed Sites so that in the 
future all pop-ups from WhenToWork.com web pages will be displayed. 

 
Setting preferences in Firefox to allow pop-ups from WhenToWork.com website 

Another option is to change the settings in Firefox browser preferences to allow popups from 
WhenToWork.com website, to use that method follow the steps below: 

1. From the Tools menu select Options  
2. Click on the Web Features tab located on the left of the window



3. In there you will see a checked option called Block Popup Windows, to the right of this is a 
button titled Allowed Sites click on this button.  

4. In the Address of web site field enter WhenToWork.com and check Allow. The 
WhenToWork.com website should now appear in the list of allowed sites as shown below. 



  

Related Topics:  
Unpublishing  
Making Changes (after Publishing)  
Publishing an Open Schedule     

  
5. Click OK twice to save and exit.  

This will make Firefox save the WhenToWork.com web site in it's list of Allow Sites so that in the future all 
pop-ups from WhenToWork.com will be displayed. 
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No Employees Appear to Be Available 
  
Be sure your employees are all set as to what Positions they can work.  If you have 
created Positions and not set any Employees as able to work them you will not see 
anyone listed as available to work those shifts. 
  

Setting Each Employee's Positions  
Related Topics: 
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Printing Problems - Page Breaks - Print Background Colors 

To save a page and print it using another program:  

 
Print Margins and Portrait - Landscape Settings 
To set how your printer controls printouts you can change your browser options 
under File - Page Setup. 

Page Breaks 
If your want better control over how your browser and printer handle the printouts 
(page breaks etc.) you can try the following: 

If you are using the By Employee schedule view try unchecking the 
"Show the date header once on each page" option in the "Change 
Layout" window.  This may result in your printout be slightly longer 
but it will prevent pages from breaking within an employee's row.  

Try changing the schedule "Change Layout" Print options (font size 
etc.)  

Try printing a filtered schedule.  Ex. filter your schedule first to show 
one position, position group or category at a time. Then print and 
repeat for each Position or Position Group.  

Or try adjusting the margins in your browser under File/Page Setup.  

You can save the "printer friendly" page and use a word processing 
program to make whatever changes you like to the page and then 
print from that program.  
  

From any page you want to save 
Click Print  
When your printer dialog window comes up click Cancel  
In the top menu of your browser Choose File>Save As  

 

  

 
Save the file to your computer and then open it with your word processing or other program.  

 
Background colors not printing 
If your color printouts are not including the blocks of color it is probably because your browser is not set to "Print 
Background Colors." 



To Turn on background color Printing - Internet Explorer  

    1.  On your Internet Explorer browser tool bar choose "Tools" 
    2.  Choose "Internet Options" to bring up a small popup options screen 
    3.  Click on the "Advanced" tab (may be the last tab option) and you 
will see a long list of checkbox choices. 
    4.  Scroll down to the Printing section and there should be an option called "Print background colors and 
images" which you should check to yes 
then save by clicking "Ok" 
  

 
  

To Turn on background color Printing - FIREFOX 

    1.  On your Firefox browser tool bar choose "File"  
    2.  Choose "Page Options" to bring up a small popup options screen 
    3.  On the Format & Options Tab check the box next to "Print Background (colors and images)" 
    4. Click the Okay button
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Buttons are Missing (Import etc.)  
  

Related Topics:  
Unpublishing  
Making Changes (after Publishing)  
Publishing an Open Schedule    

  

After publishing a schedule certain functions and buttons are no longer visible. (Import, AutoFill, Clear/Delete) It 
is assumed that you will be making only minor changes to the schedule after you publish it. Be sure that before 
you publish you have completed the scheduling as much as possible. 

You can always make changes to shifts on Published schedules by clicking the shift on any weekly schedule 
view or by using the Multi-Shift Edit view to change a number of shifts at once. 
 
If you have a lot of changes to make to an already published schedule you may want to Unpublish the week, 
make the changes and then Publish it again. Please see UnPublishing for important information on this topic. 
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Blue Screen - Pages not Being Updated  
  
Many times when you make a change in a popup window our system sends a command to the main window 
below to Refresh the information to reflect the change you just made.  

Sometimes if you have other browser windows open your browser can lose track of the parent window's location 
so when the popup sends the Refresh command it cannot determine which window to refresh and therefore 
leaves the blue screen up to indicate the command was not properly completed.  Note that your data changes 
are always saved, and this is merely an issue with your browser not refreshing the bottom window 
automatically.   

  
Usually this refresh problem is due to instability in your browser (most often Internet Explorer), and closing and 
reopening Internet Explorer or a restart of your computer fixes the problem. 

However if you have restarted your computer and the problem is still occurring, it may be due to Spyware 
running on your computer. You might try using our system on another computer to find out if the problem is 
isolated to your computer system. If both computers have the problem, please let us know.  If you do not have 
this problem on the second computer, we recommend running anti-spyware programs like Spybot SD or 
AdAware (both are free) to scan your first computer to detect spyware that may be adversely affecting your 
internet browsing of secure web sites.   

  
Since your data is always saved, the blue screen problem can be temporarily worked around by just closing the 
popup blue screen and clicking the screen's Refresh/Reload button (or pressing F5 key) to manually reload the 
page. 
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User not receiving e-mails.  
  
If an employee or manager is not receiving e-mails sent from WhenToWork, a spam filter in their e-mail program 
likely is stopping the messages. Sometimes the spam filters will allow some e-mails from us but not others, 
depending on the content of the text. 

Have the user check their e-mail program and be sure it is set to always accept messages from 
When2Work.com and WhenToWork.com 

HOTMAIL users note that messages from When2Work may end up in the Deleted folder - be sure that Hotmail 
is NOT set to automatically purge the deleted e-mails. Once Hotmail is reset to retain deleted messages in the 
Deleted folder then messages can be retrieved from the Deleted folder and marked as NOT SPAM so that they 
go to the Inbox in the future. 
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Receiving E-mails but not Messages  
 
If you have added a manager to your account and they also work as an employee they will have two sign-in ID's 
and passwords. Occasionally employees will message a manager at the manager's employee account instead 
of the manager account. The Manager will receive a forwarded EMail but not see that message when they sign 
in as Manager.  
 
Managers who are also employees can periodically sign in using their employee ID to clear out any messages 
that got sent there by mistake.  
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Employees Receiving a lot of Schedule Changes  
  

Related Topics:  
Unpublishing  
Making Changes (after Publishing)  
Why Publish a Schedule?     

  

  

  

If you have published a schedule - then the changes you make to that schedule week are automatically sent to 
any affected employees. If you plan to make a lot of changes to a published weekly schedule you might want to 
"Unpublish" it - make the changes and then re-Publish it.  
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Workaround for Adding Employee Photos  
 
WhenToWork does not currently have a way to add photos for employees but you can 
display a photo that is posted on a remote web site.  If the remote site where the photos 
are found is not a sure (https) site you will receive a warning asking if you want to 
display non-secure graphics when the page is loaded. 

Upload your photo to an online photo website such as http://picasaweb.google.com/  or 
to your company web site. Right click the photo to get the exact url web address of the 
photo. 

In the Edit Employee Comments field type this html code for adding each photo 
replacing the word url with your photo url: 

<img src='url'> 

Ex. <img src='http://yourdomain.com/w2wrb1.gif'> 

or    <img src='https://yourdomain.com/w2wrb1.gif'> 
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MAC Troubleshooting  
  
EMPLOYEE PREFERENCES: If employees have problems using our "Paint" preference colors feature they can 
enter the times use the form on that page. They can choose the color and then choose the start and end time 
then click "Add" button. This should allow them to enter their preferences without having to paint the information. 

TIME OFF: If employees have trouble seeing the time off calendar they can still enter Time Off requests by just 
typing in the date into the "Date:" box. If they simply type over the "Click calendar to choose date" words and put 
in a date in the following format: mm/dd/yyyy, then submit request as usual it should have no problem. The date 
is required to be in that format to work, so for example the sixth of February 2007 date would be 02/06/2007 
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Track Changes to Shifts - Shift History 
 
Managers (with permission to edit shifts) can click on a shift and see a link to access a "Shift History" that shows 
shift creation and log of change details for the last 30 days. This can be useful to track who changed details 
about a shift or assigned it. 

If you allow employees to trade or pick up shifts "At Will" you will see the employee that "changed" a shift and 
picked it up along with when the shift was originally created and any other changes made. 

Viewing the Shift History Using the By Employee View: 
From the By Employee Schedule View 

Click the shift to open the Quick Shift EDIT window  
Click the Shift History link in the upper right  

 

Using Other Weekly Schedule Views: 
From the Schedule View 

Click the Shift to open the Shift Change window  
Click the Shift History link in the upper right  



Related Topics:  
Clicking a Shift to Edit, Delete, Clone or Assign  
Deleting Multiple Shifts   
Tracking Schedule Changes - Import, AutoFill, Publish 
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